
 pg. 1 

   

Intuit Field Service Management 

 
 

Corrigo Integration Client  

For QuickBooks 

 

 

 

Installation & Setup Guide 

  

  

  

  

  

  



 pg. 2 

 
This documentation and related computer software program (hereinafter referred to as the “Documentation”) is for the end user's 

informational purposes only and is subject to change or withdrawal by Corrigo Incorporated at any time.  

THIS DOCUMENTATION MAY NOT BE COPIED, TRANSFERRED, REPRODUCED, DISCLOSED OR DUPLICATED,  
IN WHOLE OR IN PART, WITHOUT THE PRIOR WRITTEN CONSENT OF CORRIGO. THIS DOCUMENTATION IS 

PROPRIETARY INFORMATION OF CORRIGO AND PROTECTED BY THE COPYRIGHT LAWS OF THE UNITED STATES AND 

INTERNATIONAL TREATIES.  

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CORRIGO PROVIDES THIS DOCUMENTATION “AS IS”  
WITHOUT WARRANTY OF ANY KIND, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF 

MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT. IN NO EVENTWILL  
CORRIGO BE LIABLE TO THE END USER OR ANY THIRD PARTY FOR ANY LOSS OR DAMAGE, DIRECT OR  
INDIRECT, FROM THE USE OF THIS DOCUMENTATION, INCLUDING WITHOUT LIMITATION, LOST PROFITS, BUSINESS 

INTERRUPTION, GOODWILL OR LOST DATA, EVEN IF CORRIGO IS EXPRESSLY ADVISED OF SUCH LOSS OR DAMAGE.  

THE USE OF ANY PRODUCT REFERENCED IN THIS DOCUMENTATION AND THIS DOCUMENTATION IS GOVERNED BY 

THE APPLICABLE END USER'S LICENSE AGREEMENT.  

The manufacturer of this documentation is Corrigo Incorporated.  

Provided with “Restricted Rights” as set forth in 48 C.F.R. Section 12.212, 48 C.F.R. Sections 52.227-19(c)(1) and (2) or DFARS Section 

252.227.7013(c)(1)(ii) or applicable successor provisions.  

© 2007 - 2014 Corrigo Incorporated, 8245 SW Tualatin Sherwood Rd. Tualatin, OR 97062. All rights reserved.  
All product names referenced herein belong to their respective companies.  

Version 6.10 JRP 07/30/2010 1:15 PM   

Updated August 20 2014 by MHS and JT  



 pg. 3 

  

 

  

Table of Contents 
Overview ........................................................................................................................................................................ 5 

Using This Guide ........................................................................................................................................................ 5 

System Requirements ................................................................................................................................................ 6 

Technical Support: ......................................................................................................................................................... 6 

Before You Connect QB to FSM ..................................................................................................................................... 6 

QuickBooks Company File Considerations and Potential Clean-Up Areas ................................................................ 6 

Installing the Corrigo Integration Client ........................................................................................................................ 7 

Overview .................................................................................................................................................................... 7 

To Install the Corrigo Integration Client: ................................................................................................................... 8 

Initial Synchronization Setup ....................................................................................................................................... 13 

Overview .................................................................................................................................................................. 13 

QuickBooks Settings for Inventory Tracking ............................................................................................................ 13 

QuickBooks Settings for Time Card users ................................................................................................................ 14 

Using the Setup Wizard ........................................................................................................................................... 18 

Field Service Management Authentication Settings ................................................................................................ 20 

Customer Synchronization Settings ......................................................................................................................... 22 

Item Synchronization Settings ................................................................................................................................. 25 

Inventory Item Synchronization............................................................................................................................... 26 

Invoice Settings ........................................................................................................................................................ 26 

Time Card Settings ................................................................................................................................................... 29 

Completing Initial Synchronization Wizard .............................................................................................................. 31 

Synchronizing the Systems .......................................................................................................................................... 31 

Overview .................................................................................................................................................................. 31 

Starting the Synchronization Wizard ....................................................................................................................... 32 

Customer Synchronization ....................................................................................................................................... 40 

Item Synchronization ............................................................................................................................................... 43 

  

   



 pg. 4 

Group Item Synchronization .................................................................................................................................... 44 

Retrieval of Employees with Approved Invoices...................................................................................................... 46 

Associate Field Service Management employees with QuickBooks employees and Sales Reps ............................. 47 

Invoice Export .......................................................................................................................................................... 47 

Payment Method Mapping ...................................................................................................................................... 51 

Time Card Synchronization (for Time Card users) ....................................................................................................... 55 

Running Corrigo Integration in network share setup .................................................................................................. 60 

Automatic Update of the Corrigo Integration Client ............................................................................................... 62 

Troubleshooting ........................................................................................................................................................... 63 

Frequently Asked Questions .................................................................................................................................... 63 

Technical Support: ....................................................................................................................................................... 64 

 

  



 pg. 5 

  Corrigo Integration Client for QuickBooks – 
Installation & Setup Guide 

Overview  
This guide explains how to implement the Corrigo Integration Client for QuickBooks. The following assumptions apply to the 

use of this guide:  

• You utilize QuickBooks as your business accounting software (see System Requirements in this guide for additional 

information)  

• Your QuickBooks application runs on a computer that has Internet access.  

• You have a valid URL, user ID, and password for your Intuit Field Service Management product.  

• You have a basic understanding of how to access, navigate, and use both QuickBooks and your Intuit Field Service 

Management product.  

Using This Guide  
Appearance:  Since your company can customize Service Management by changing 

screen appearance, words, and phrases used in the application, some 

images used in this guide may not exactly match those that appear on 

your screens.  

Conventions:  
The Intuit Field Service Management product you use will be referred to as 

Field Service Management, the web application, or just application within 

this guide. All supported versions of QuickBooks will be referred to merely 

as QuickBooks, unless otherwise noted. The Corrigo Integration Client for 

QuickBooks will be referred to as the integration client.  

Path Reference:  Path references will be used in this guide to direct you to the appropriate 

screen within your software products. For example, to reach the client 

download screen in Field Service Management, the path is Settings > 

Company > Integration. This means that, within your Field Service 

Management web application, you select the Settings page, choose the 

Company tab on that page, then select the Integration option from the 

Company menu.  

 

 

System Administrator:  This is the person at your company who manages your Field Service Management 

and QuickBooks programs. The term System Administrator is used in this guide.  
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System Requirements  

Minimum system requirements for the machine running the sync between FSM and QB:   

• High speed Internet connection 

• 1024 by 768 screen resolution 

• QuickBooks Pro/Premier/Enterprise Desktop Software version 2012 or later running on Microsoft 

Windows Vista Business 32 or 64 bit, Vista Ultimate 32 or 64 bit, Windows 7 Business 32 or 64 bit, 

Windows 7  Ultimate 32 or 64 bit, Windows 8 Business 32 or 64 bit, Windows 8 Ultimate 32 or 64 bit.  

Windows Vista “Home Edition ”, Windows 7 “Home Edition”, and Windows 8 “Home Edition” not 

supported (they will not sync). 

• At least 1 GB RAM 

• At least 1.6 GHz processor 

• 1 GB available hard-disk space 

QuickBooks versions supported: The Corrigo Integration Client can be used with the following QuickBooks 

versions:   

• Pro, Premier, and Enterprise versions from 2012 and newer, running on Microsoft Vista or Windows 7/8 

Business or Ultimate operating systems (32 bit and 64 bit).  

 

Technical Support:  

 Helpful videos during the Installation and Setup process: http://vimeo.com/intuitfieldsvc/albums to watch 

the “Phase 1” video series. 

 Field Service Management technical support:   1-800-517-2871 (toll-free)  

 Email: support@corrigo.com 

 Local Experts for personalized setup assistance, QB file cleanup, and FSM training: 

http://fieldservicesuccess.com/2012/11/07/local-experts  

Before You Connect QB to FSM 

QuickBooks Company File Considerations and Potential Clean-Up Areas 

Please review this list of potential clean-up areas prior to your initial synchronization between QuickBooks and Intuit Field 

Service Management (FSM).    

1. Look in QB and determine if you are using more than one type of customer in QB.   
FSM supports two types of customers: Residential or Commercial.  Commercial customers in FSM have a field for 
“Company”, while Residential customers do not. If this is important to you for reporting purposes or customer 
record appearance you will want to go through your customers in QB to ensure the customer type is set to 
something you can map to either residential or commercial.  In most cases this is not something that FSM 
customers have needed to do, but you cannot correct the customer type after they have been created/imported 
into FSM. 

http://vimeo.com/intuitfieldsvc/albums
mailto:support@corrigo.com
http://fieldservicesuccess.com/2012/11/07/local-experts
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2. Sync errors: QB customers will not sync to FSM if there is an invalid entry in the billing/ship to addresses or the 
email field. If you are using these fields in QB for something other than the appropriate information the customer 
will not sync until you fix the customer record. Usually this is corrected after the initial sync since FSM will give you 
a list of exact records that were not able to sync and why.  However, if you are planning to review your customer 
list prior to sync it would be a good idea to correct any errors on these records first. 

3. Customers and Jobs in QB:  Jobs in QuickBooks = Sites/Locations in Field Service Management.   If prior to 
purchasing FSM your business has been using Jobs in QB as “work orders”, you probably have many Jobs in QB for 
the same “Customer Site”.  If this is the case, please call FSM Support prior to running the First-time sync between 
FSM and QB to discuss ways to manage your existing QB customers and jobs when synced into FSM.  

4. Service/site address: FSM pulls the billing information from the QB “Bill To” field and the service/site address from 
the “Ship To” field.  Even if the billing and service addresses are the same for your customer, there must be entries 
in both the “Bill To” and the “Ship To” in QB.  If the “Ship To” in QB is left empty, then there will not be an address 
on the work orders in FSM for those customers. There are several ways this can be corrected: 

a. One at a time in QB by clicking the “copy” button between the addresses in the customers’ records. 
b. In FSM by editing the site address when customers call in for service. 
c. All at once by exporting your customer list from QB to Excel and copy the “Bill To” columns to the “Ship 

To” columns and importing the list back into QB. 
i. If this is what you would like to do then any questions should be directed to Intuit QuickBooks 

Support. 
5. Work zones:  If you need to setup multiple office locations in two or more service areas (usually different cities, 

states, etc.) then you should contact support@corrigo.com, call 800-517-2871, or one of our Local Experts to assist 
you. This must be setup correctly before your initial sync to bring customers into FSM or you will not have another 
opportunity. 

6. Estimating the time for Initial Sync between QB and FSM:  It takes about an hour per chunk of 1,000 records.  To 
save time any customer records or job levels that can be made “inactive” should be made inactive prior to the 
initial sync with FSM.  FSM will not attempt to sync inactive items, customers, or jobs from QB.  If you have more 
than 6,000 customers/jobs in QB, we recommend inactivating records so you are bringing them into FSM in 
increments of 5,000. 

 

Installing the Corrigo Integration Client  

Overview  

In order to integrate Field Service Management with your QuickBooks accounting system, you will first need to install the 

Corrigo Integration Client for QuickBooks. The “FSM” Integration Client is typically installed on only one computer in the 

office.  If the QuickBooks company file is installed on a server, the FSM Integration Client is, nevertheless, installed typically 

on a desktop PC or laptop (not onto the server itself) and accesses the QB Company file that is located on the server.  Also, 

the “FSM sync” is NOT the same as the “QuickBooks Web Connector”.  If necessary, you may also want to refer to “Running 

the Corrigo Integration Client in a network share setup” later in this guide. 

Once installed, the FSM integration client will enable you to synchronize customers and items, export/update web 

application invoices and payments to QuickBooks, and map payment methods between the two systems. Time Card users 

can export time card information.    

If you desire to be able to perform the FSM Sync from more than one PC in the office, or if you want to move the FSM Sync 

to a different computer, or if you wish change the “file path” referenced by the FSM Sync, please contact FSM Technical 

Support prior to making these changes. 

mailto:support@corrigo.com
http://fieldservicesuccess.com/2012/11/07/local-experts/
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Prior to installing the FSM Integration Client on your PC it is recommended that you first check to make sure you have 

already installed all necessary QuickBooks updates.  This may require closing QuickBooks several times and/or rebooting 

your computer, but will ensure the FSM Integration Client is making use of the newest file paths and database structures.   

To update QuickBooks: 

1. Launch QuickBooks and log in as the Administrator 

2. Select Help > Update QuickBooks 

3. Select Update Now 

4. Click Get Updates 

5. Once QuickBooks is updated, close the Update QuickBooks window. 

6. Close QuickBooks itself. 

7. Launch QuickBooks as the Administrator by right-clicking on the QB icon and choosing “Run As Administrator” 

8. You will be asked if you want to install recently downloaded updates.  Choose Yes.  You may be asked if you want to 

continue with the program or for permission to restart your computer, and your security software may ask for 

permission to install the QuickBooks update.  Choose Yes. 

9. Once the updates are installed, Close QuickBooks.  You may now proceed to Install the Corrigo (FSM) Integration 

Client. 

 

To Install the Corrigo Integration Client:  

1. On the computer where you wish to install the FSM Integration Client, Close QuickBooks itself.  Then open 

your Task Manager (CTRL+ALT+DEL) and end the “QBW32.EXE” process for Vista/Windows 7 users, or the 

“QuickBooks 32 bit” for Windows 8 users (these steps ensure QB itself is completely closed). 

2. Log into Field Service Management from either www.Apps.com or www.workordernetwork.com.  

3. Within the web application, go to Settings > Company >  Integration.  

 

  

  
    

http://www.apps.com/
http://www.workordernetwork.com/
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4. Click Edit on “Do you want to integrate with QuickBooks?”  

 
7. Click Install Corrigo QuickBooks Integration Client (this button becomes active once Step 6 is completed). 

Note: write down the Authentication Code you created—QuickBooks will ask this for this code the first 

time you sync between FSM and QB. 
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8. You will be presented with the option to Run or Save the file setup.exe. Choose Run.  

  
Figure 2:  Sample File Download screen from Microsoft Windows XP Media Center Edition, version 2002  

Note: Depending upon your operating system and security software, you may receive additional messages. In 

general, choose options that allow you to accept and run this file from Corrigo   

9. You will be greeted by the setup program. Close your QuickBooks application and click Next.  
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 Figure 3:  Close QuickBooks and click Next when this screen appears  

10. Click through the setup program as prompted.   

Note: You will be given the option to choose your own folder where the client files will be installed. Corrigo 

recommends that you choose the default option unless otherwise directed.  
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 Figure 4a:  Corrigo recommends choosing the default installation folder   

11. Click Close when you receive a message stating that installation is complete.  

12. Your Corrigo Integration Client for QuickBooks is now installed and available for use within QuickBooks. 

Locate the QuickBooks icon on your Desktop or menu, Right-click the icon, and choose “Run as 

administrator” and log into QuickBooks as the QB Admin.   

  
Figure 4b:  Run the QuickBooks as administrator at this point   
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Initial Synchronization Setup  

Overview  

Once the client is installed, you will need to configure settings for integration between Field Service Management and 

QuickBooks. This consists of deciding how various fields and functions will associate between the two systems. Setup is 

completed through the Initial Synchronization Setup Wizard, which will walk you through each step.  

o If you want to synchronize inventory tracking between QuickBooks and Field Service 

Management: Prior to running the setup wizard, you must activate inventory tracking in 

QuickBooks. See QuickBooks Settings for Inventory Tracking below for additional information.  

o Time Card Module users: Prior to running the setup wizard, you must make adjustments to your 

QuickBooks configuration. See Time Card Synchronization in the Table Of Contents.  

Note: If your company is running QuickBooks in multi-user mode, make sure the user running the synchronization is logged 

in as an administrator and has rights to access external applications. See your QuickBooks documentation for information on 

how to set user rights.  

QuickBooks Settings for Inventory Tracking  

Field Service Management allows you to synchronize QuickBooks inventory items for inventory tracking. Inventory Items are 

items for which you track quantities purchased, on-hand, and sold. You can create inventory items in QuickBooks and export 

them into Field Service Management. Any inventory item sold in Field Service Management will be decremented from the 

inventory tracking count in QuickBooks.  

If you want to set up the Corrigo Integration Client to synchronize inventory items, you must activate  

Inventory and Purchase Orders within QuickBooks. To do this, go to Edit > Preferences > Items & Inventory > Company 

Preferences, then check Inventory and purchase orders are active (this is the location in most versions of QuickBooks. 

Consult your QuickBooks documentation if Company Preferences is not found on this path for your version).  

After activating inventory tracking, set up inventory items within QuickBooks so that they can export to Field Service 

Management (see QuickBooks documentation to learn how to set up inventory items).  
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Figure 7:  In QuickBooks, go to Edit > Preferences > Items & Inventory > Company Preferences and check Inventory and 

purchase orders are active in order to synchronize inventory items with Field  

Service Management  

QuickBooks Settings for Time Card users  

Prior to running the Initial Synchronization Setup Wizard, Time Card users must configure QuickBooks for synchronization.  

First, you must set up QuickBooks payroll items to associate with Field Service Management hourly rates. This can be 

accomplished through the Change New Employee Default Settings feature within QuickBooks. Refer to your QuickBooks 

documentation for additional information.  Note:  To proceed through the initial synchronization you must have the 

following Item Names in QuickBooks:  Regular, Overtime, and Double-time. 
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 Figure 8:  Sample of Employee Default Settings Screen from QuickBooks Enterprise v14  

Next, you need to configure QuickBooks to allow the Corrigo Integration Client access to personal data. To change this 

setting:  

1. Go to Edit > Preferences > Integrated Applications > Company Preferences (this is the location in most 

versions of QuickBooks. Consult your QuickBooks documentation if Company Preferences is not found on 

this path for your version).  

2. Click on Corrigo Integration (under Application Name).  

3. Click the Properties button.  

4. Click the Access Rights tab atop the Properties edit screen.  

5. Check each of the following settings:  

a. Allow this application to read and modify this company file  

b. Allow this application to access Social Security Numbers, customer credit card information, and 

other personal data  

Note: It is necessary to allow the Corrigo client access to personal data in order for the integration to 

occur. However, the integration client does not access or modify Social Security Numbers or customer 

credit card information.  

6. Click OK when done.  

Modifying these settings will allow the Corrigo Integration client access to the necessary data files in QuickBooks.  

Note: While running the integration client, if you receive the message: “Application doesn’t have access to QuickBooks 

personal data. Please correct this and click Next to continue” then you have not correctly set the QuickBooks settings 

described in this section. Re-check the settings.  You do not need to cancel the integration process to change the settings.  
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Figure 9:  Select Properties for the Intuit Field Svc. Integration client (upper left), then check the access settings (lower right), 

under the Access Rights tab (sample above from QuickBooks Enterprise v14).  
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Launching the Setup Wizard  

If you just completed installation of the Corrigo Integration Client, the setup wizard will launch automatically the next time 

you start QuickBooks. If the wizard doesn’t start or you cancel it for any reason, you can start it manually by selecting File > 

Corrigo Integration > Sychronize from the QuickBooks menu bar. 

  

Figure 10a, 10b: Select File > Intuit Field Svc. Integration > Settings within QuickBooks to manually launch the settings area.   

Note: if the Intuit Field Svc. Integration option is missing from the File menu, please do the following: 

1. Exit QuickBooks. 

2. Open Task Manager (CTRL+ALT+DEL) 

3. Access the Processes tab and End the following processes if they appear the listing:  QBW32.EXE (on Windows 

Vista/Windows 7), QuickBooks 32 bit (on Windows 8), and QBEventsShim/CorrigoEventsShim 

4. Locate the QuickBooks icon on your Desktop or menu 

5. Right-click on the QuickBooks icon and select “Run as administrator”as shown in Figure 10b 

6. When QuickBooks opens, log in with the QB Admin username 

7. Locate the Intuit Field Service Integration option on the menu.  If it is still not there, please contact FSM Technical 

Support @ 800-517-2871. 
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Using the Setup Wizard  

The wizard will walk you through each step of setting up your integration client. The first screen that appears will 

be General Synchronization Settings.   

General Synchronization Settings  

Basic Settings  

 

 

 Figure 11:  Basic General Settings screen of the Initial Synchronization Setup Wizard  

General Settings: You will be asked how the integration client should decide conflicts if updates have been made to 

the same item in both systems prior to synchronization.  

If updates are made to the same information in both systems, decide which information will remain unchanged:  

• QuickBooks Wins: QuickBooks updates remain unchanged; Field Service Management updates will be 

changed by synchronization to match QuickBooks. (If a change has been made on both sides is when this 

comes into effect.) 

• Field Service Management Wins: Field Service Management updates remain unchanged; QuickBooks 

updates will be changed by synchronization to match Field Service Management.  

• Manual: You will be given the chance to decide which updates will change if conflicts exist.  

Next, choose how often you should be prompted to synchronize the two systems. One day is the minimum as well 

as default time that the system will remind you to synchronize.  

Note:  You can manually synchronize at any time by selecting File > Corrigo Integration > Synchronize from the 

QuickBooks menu when logged in as an administrator.  
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Backup Settings: The repository is a file on your computer that contains a record of information you have 

synchronized. If this file is deleted or corrupted, you will need to restore it from a backup in order to recover 

mappings and associations that you’ve made in past synchronizations. Choose where and how often to create a 

backup of your repository.  

Once the Initial Setup Wizard is run, you can also manually backup the repository file at any time by accessing File 

> Corrigo Integration > Settings > General Settings > Create Backup from within QuickBooks.  

Advanced Settings  

 

 Figure 12:  Advanced General Settings screen of the Initial Synchronization Setup Wizard  

  

Who should turn off On Demand sync?  

Any business running QuickBooks in multi-user mode in QuickBooks should turn off On-Demand sync.  If you have 

multiple work zones created in Field Service Management and would like to put customers you create in 

QuickBooks into specific work zones please turn off On Demand sync. Otherwise On-Demand sync will use the 

default work zone that is defined in synchronization settings for all the new customers you create in QuickBooks.  

On Demand Sync Settings: On-Demand sync settings help you enable or disable real-time sync. That is if  

On Demand sync is turned on any edits or additions you make to your customer and items in  

QuickBooks will be automatically reflected in Field Service Management without you having to run the sync 

explicitly. But for any changes that have been made to customer or items in Field Service Management to get 

across to QuickBooks you will have to run the sync explicitly.   

Automatic Sites/Jobs Update: If you want QuickBooks to get automatically updated whenever a Site/Job is created 

or edited in Field Service Management, you need to select ‘Yes’ for this setting. If you select ‘No’, updates will be 

synced up only when you explicitly run the synchronization.  
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This functionality is mainly introduced to cover the scenario where you might create a new site/job for a customer 

in Field Service Management while creating a work order and you need to add a PO for that site/job immediately in 

QuickBooks. Hence this automatic process will run only if the customer:sites/jobs to be updated is less than or 

equal to 50 records.  

Automatic Sites/Jobs process will run only on one computer at any point of time when you are working in a 

network share environment.   

For example if computer A and B have integration client installed and are accessing the same QuickBooks company 

file on a server and if automatic customer:sites/jobs sync process started on computer A, a warning message will 

be displayed in computer B that automatic process is running in the background on computer A and that explicit 

sync or settings change cannot be done at that point. You will be able to perform any settings change or run sync 

after the “lock down” period of 20 minutes.  

Note: Once you make any change to this setting, please close QuickBooks and open it again for the change in 

configuration to take effect.  

Click Next when done.  

 

Field Service Management Authentication Settings  

On the next screen, enter the Authentication code and Field Service Management company name you created 

inside Field Service Management web application (just prior to downloading the Setup program).   

  
Figure 13:  Enter the authentication information  

You can get the authentication code and company name by logging into your Field Service Management 

application and navigating to Settings > Company > Integration Settings.  
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Figure 14: Integration settings in Field Service Management application  

Click on ‘Edit’ link for Integration Client Authentication Code, enter the code and re-enter to confirm and click on 

Save. Note the company name displayed on the screen.   Note:  the Authentication Code inside FSM is a code you 

create yourself – it does not come from Intuit or Corrigo. 

Enter the authentication you set and the company name in the authentication settings screen in Integration 

settings wizard.  

Note: Clicking Next after entering this information will validate your authentication with Corrigo. You must be 

connected to the Internet in order to proceed.  
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Customer Synchronization Settings  

On this screen, you will decide how customer records will synchronize between QB and FSM.   

For Customers Imported from QuickBooks into Field Service Management: Assign Field Service Management 

customer types, work zones, and service packages to the new customers from QuickBooks.  

QuickBooks does not use work zones or service packages in its customer records When customers created within 

QuickBooks are exported into Field Service Management, they will be added using the work zone and service 

package you select. QuickBooks customers of all types will be added to Field Service Management using the default 

customer type you select (choose between either Residential or Commercial).    

  
Figure 15:  Customer Synchronization Settings  

 

For Customers Imported from Field Service Management into QuickBooks: Assign QuickBooks customer types to 

the new customers from Field Service Management.   

Two customer types exist within Field Service Management: Residential and Commercial.  Since 

QuickBooks supports additional customer types, you need to decide how the two Field Service 

Management types will be mapped for customers imported into QuickBooks.  

 You can select a QuickBooks customer type from the drop-down menu:   
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 Click create a new customer type in QuickBooks:  

 

 

Figure 16: Select customer type (left image) from drop-down menu, or create a new type (right image) 
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Select how you want your customer list synchronized:  Most businesses using Intuit Field Service Management 

have one “site” in FSM for each service location in QB, with each site having its own equipment list and service 

history.   Based on number of levels you select here Field Service Management will import jobs from QuickBooks 

to create customer sites inside FSM.  Once you complete the Initial Synchronization Wizard, this setting cannot 

be changed.  

 

Figure 15a:  Example of Residential Customer (one work site/location) in QB and how it appears after sync into FSM 

 

 

Figure 15b: Example of Commercial Customer (two service addresses) in QB and how this appears after sync into FSM 
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Item Synchronization Settings  

On the next screen, you will select defaults for service, non-inventory, and inventory part items. These item types 

are the only QuickBooks types supported in the web application’s Price List categories.  

 

Figure 17:  Item synchronization settings example  

First, select the QuickBooks accounts that should be used as default accounts for service and non-inventory part 

items exported from Field Service Management.  

Next, associate Field Service Management Price List categories with QuickBooks items. These associations will be 

used to set up QuickBooks items imported into Field Service Management. When associating Price List categories 

with QuickBooks Items:  

• Each QuickBooks Item must each be associated with at least one (or more) Price List category  

• Each Price List Category must be associated with only one QuickBooks Item (Service, non-inventory, or 

inventory parts)  

Price list categories must exist within the web application in order for this integration setup to be completed. You 

may add a new Price List category to Field Service Management from this screen if necessary.   
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Pick a default Tax Agency that you want to associate the sales tax items and groups created in Field Service 

Management. Sales tax items and groups that you created in Field Service Management will get the agency you 

select here as the associated tax agency when these items are exported to QuickBooks.  

Note: You cannot use the same Price List category for multiple QuickBooks item types. For example, once you have 

selected a Price List category to associate with QuickBooks Service Items, that category will not be available to 

select for Non-inventory Part Items (and vice versa).  You may, however, unselect the category to make it available 

again.  

Inventory Item Synchronization  

Field Service Management allows you to synchronize QuickBooks inventory items for inventory tracking. Inventory 

Items are items for which you track quantities purchased, on-hand, and sold. You can create inventory items in 

QuickBooks and export them into Field Service Management. Some notable features:  

• The Corrigo Integration Client will import QuickBooks Inventory items into Field Service Management, in 

addition to Services and Non-Inventory items  

• Inventory item name, description and sale price will import (other inventory related fields will not be 

synchronized)  

• The Integration Client items settings grid will allow you to associate QuickBooks inventory items with Field 

Service Management price list categories  

• The Integration Client will check to see if Inventory setting is enabled in QuickBooks before the 

synchronization will function (see QuickBooks Settings for Inventory Tracking in this guide for details).  

• When Field Service Management invoices that include inventory items are exported to QuickBooks, the 

inventory item count is automatically decremented in QuickBooks  

Invoice Settings  

This screen allows you to select how invoices created in the web application are synchronized into QuickBooks.   

Basic Settings  

You will be required to do only the basic settings in most cases.   
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Figure 18:  Invoice Basic settings screen  

Checking Invoice to be printed and Invoice to be e-mailed will activate these options in QuickBooks after the 

synchronization is complete.  

Note: If you check Invoice to be emailed, your customer contact records must include a valid email address or 

invoice synchronization will fail.  

Work Done Description: In Field Service Management, a Work Done description is pulled from the work order and 

reflected on the Field Service Management invoice as a separate note. In order for this work done information to 

appear on QuickBooks invoices, you must select Yes to indicate that you want to export the work done 

information. Next, select from the drop-down menu where you want the information to appear on the QuickBooks 

invoice (for example, as the first line item on the invoice).  

Invoice Numbering Scheme: Invoices created in Field Service Management will have the same number as the work 

orders. So invoices exported to QuickBooks will have the Work Order number as the invoice number.  This 

sometimes could lead to duplicate invoice numbering if you also do some invoicing in  

QuickBooks directly. You can avoid that problem by choosing a numbering scheme that suite your needs.  

• Use Field Service Management Invoice Numbering – Select this option if you would only use Field Service 

Management for creating invoices.  

• Use QuickBooks Invoice Numbering – Select this option if you also use QuickBooks to create some 

invoices. This will pick the last invoice number in QuickBooks and will increment the numbering for all the 

invoices exported from Field Service Management. Field Service Management invoice number will be 

added in the memo field of QuickBooks invoice for crossreferencing.  

Populate Sales Rep Field:  You can populate the ‘Rep’ field in QuickBooks invoice, with the primary technician who 

did that work order, by selecting ‘Yes’ to this setting.  
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Note: If a corresponding employee and or a sales rep are not defined in QuickBooks, you will have the option to 

create them in QuickBooks when you go through the synchronization wizard.  

Subtotal Item: In QuickBooks you can have several subtotal items whereas in Field Service Management there is 

only one. So the single Field Service Management subtotal item needs to be mapped to a QuickBooks subtotal item 

in order for the invoices to get exported.   

Discount Item: In QuickBooks you can have several discount items whereas in Field Service Management there is 

only one. So the single Field Service Management discount item needs to be mapped to a QuickBooks discount 

item in order for the invoices to get exported.   

Advanced Settings  

  

Figure 19:  Invoice Advanced settings screen  

You will be required to do the Advanced settings only if you had used Field Service Management system without 

QuickBooks integration turned on for a while. In such a scenario you will have three generic items called Labor, 

Parts and Misc. which you need to map to one of your other charge items in QuickBooks.   

You can select the appropriate QuickBooks item from the drop-down, or click the  icon to add a new other 

charge item to QuickBooks.  
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Inventory 

Customers with QuickBooks Enterprise Edition have the ability to create and track inventory within multiple 

locations inside QuickBooks through a QuickBooks module called “Advanced Inventory”.  Integration between FSM 

and the Advanced Inventory allows you to define the mapping of the field technicians to the inventory locations in 

QuickBooks.  To see how this integration works, check out this video:   

http://vimeo.com/intuitfieldsvc/advancedinventory  

 

Figure 19b: Advanced Inventory tab (only for QBES customers with the Advanced Inventory module)  

 

Time Card Settings   

This section applies to companies using the optional Time Card module.  Learn more about the Time Card module here: 

http://vimeo.com/intuitfieldsvc/tcmodule    

The next screen to appear will be the Time Card synchronization settings screen. From this screen you will be able 

to:  

1. Configure Import of Customer:Site along with time records  

2. Configure default payroll items and hourly rates  

http://vimeo.com/intuitfieldsvc/advancedinventory
http://vimeo.com/intuitfieldsvc/tcmodule
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Figure 20:  Time Card synchronization settings screen  

Configure Import of Customer:Site along with time records  

Do you want to import Customer:Site information for time records imported from Intuit Field Service Management 

ES? Yes/No  

The default selection for this setting will be ‘No’.  

Choose ‘Yes’ if you do job costing in QuickBooks. Individual time records will be exported for each work order done 

on a customer:site. There could be several time records for a single day depending upon the number of jobs your 

technicians perform each day. The work order number will be added for reference in each time record in the notes 

field.  

Choose ‘No’ if you don’t do job costing in QuickBooks. Number of hours worked for the entire time period will be 

aggregated and will be exported as regular, overtime and double time.   

Configure default payroll items and hourly rates   

  

Configure default hourly rates for Regular, Overtime, and Double time hours worked for employees that need to be 

created in QuickBooks during synchronization. Each default rate must be associated with a QuickBooks payroll item 

name, which you can select from the drop-down menu.  

Note: Default Payroll Item Settings will be used only when a new employee has to be created in QuickBooks during 

synchronization. The synchronization will not change the values that are already set for employees in QuickBooks.  

If conflicts arise, such as if an employee in QuickBooks has a different rate or different payroll item specified, a 

warning will be displayed during synchronization. You will then be able to define payroll items for individual 

employees in a reconcile grid.  
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Completing Initial Synchronization Wizard  

Click Finish when done. You will be given the option to review each of the settings.  

Note: If you need to adjust any of these settings after the wizard is completed, you may access the settings screen 

through File > Corrigo Integration > Settings from within QuickBooks.  

Note: If you are ever prompted by QuickBooks to re-input the initial sync settings after you have successfully 

completed the initial sync, cancel out of the prompt and contact FSM Technical Support at 800-517-2871 or 

support@corrigo.com. 

Synchronizing the Systems  

Overview  

Once the initial settings have been established, you can synchronize the two systems by utilizing a synchronization 

wizard. The first-time synchronization can take approximately one hour for each one-thousand customer records.  

Subsequent end-of-day synchronizations should take about five to ten minutes total.  Integration can occur 

between the following items:  

• Customers (full synchronization)  

• Items (service, non inventory, inventory, sales tax items, sales tax groups, item groups) - (full 

synchronization with exceptions for inventory items)  

• Sales Tax Codes (association from Field Service Management to QuickBooks)  

• Invoices (one way synchronization – from Field Service Management to QuickBooks)  

• Payment Methods (mapping from Field Service Management to QuickBooks)  

• Payments (one way synchronization – from Field Service Management to QuickBooks)  

• Time Card – for Time Card users only (one way synchronization – from Field Service Management to 

QuickBooks)  
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Starting the Synchronization Wizard  

  
Figure 21: Welcome screen of the Corrigo Integration Client synchronization wizard  

Begin synchronization by selecting the synchronization wizard. To start the wizard, log into QuickBooks as an 

administrator or full-access role and go to File > Intuit Field Svc. > Synchronize.     

Note: If your company is running a supported version of QuickBooks in multi-user mode, make sure the user 

running a synchronization is logged in as an Administrator and has rights to access external applications. See your 

QuickBooks documentation for information on how to set user rights.  

Select Next to begin the customer synchronization.  
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Sales Tax Synchronization  

  
  

Figure 22:  Sales Tax Code retrieval screen  

The Retrieval of Changed Sales Tax Codes screen will show how many updated sales tax code records have been 

retrieved. When the retrieval is complete, you will be given the chance to review and reconcile any conflicts that 

may arise.  

Click Next to continue. The next screen to appear will be Sales Tax Code reconcile grid.  
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Figure 23:  Sales Tax Code Reconcile grid  

Left column indicates all the sales tax codes you have defined in Field Service Management and the right column 

indicates all the codes you have defined in QuickBooks. You can click on ‘SELECT SALES TAX CODE’ and either select 

CREATE NEW or pick a code from the list to associate it with a QuickBooks sales tax code and vice versa.  It is 

critical to map and sync all tax codes so they will be available on subsequent synchronizations. 

  
Figure 24:  Reconcile grid showing associations  

Once you have made all the associations, the ‘Next’ button will be enabled and you can click on it to proceed to the 

next step. The next screen to appear will be Sales Tax Code association progress screen.   



 pg. 35 

  
Figure 25:  Sales Tax Codes sync in progress  

Successful association of Tax code is displayed in the progress screen. Please click on Next button to proceed to 

Sales Tax Item retrieval screen.  
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Figure 26:  Retrieval of Sales Tax Items screen  

The Retrieval of Changed Sales Tax Items screen will show how many updated sales tax item records have been 

retrieved. When the retrieval is complete, you will be given the chance to review and reconcile any conflicts that 

may arise.  

Click Next to continue. The next screen to appear will be Sales Tax Items reconcile grid.  
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Figure 27:  Sales Tax Items reconcile grid  

In the reconcile grid you can see the sales tax that are going into QuickBooks and those that are coming from 
QuickBooks into Field Service Management. You have the option to exclude an item from synchronization. You 

need to click on the sales tax item to select it and then click the ‘Do not synchronize’ icon ( ).   

Click Next to continue. The next screen to appear will be Sales Tax Items sync progress screen.   
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Figure 28:  Sales Tax Items sync progress  

Successful sync of Sales Tax Items is displayed in the progress screen. Please click on Next button to proceed to 

Sales Tax Group retrieval screen.  
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Figure 29:  Retrieval of Sales Tax Groups  

You can click on Next button to step through the reconcile step and the sync progress step similar to Sales Tax Item 

synchronization.  
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Customer Synchronization  

  
Figure 30:  Corrigo Integration Client synchronization wizard as it transfers data between systems  

The Retrieval of Changed Customers screen will show how many updated customer records have been retrieved. 

When the synchronization is complete, you will be given the chance to review and reconcile any conflicts that may 

arise.  

Note: Existing customers added to or modified in QuickBooks are automatically synchronized with the web 

application if On Demand synchronization is turned on. You do not need to run the synchronization process for this 

to occur. To update QuickBooks with customer additions and changes that were made in the web application, you 

must run the integration client.  

If you only want to run the customer synchronization and not go through the entire wizard, you can select 

‘Synchronize only Customers:Jobs’ from File Corrigo Integration menu.  

Click Next to continue. The next screen to appear will be the Customer Synchronization grid.  
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Figure 31: Corrigo Integration Client Customer synchronization grid  

The synchronization action that will be taken with each item is listed in the Action column as an icon. To change 

the action, click an item on the grid to highlight and select it. Action options available for a highlighted item are 

represented by active icons on the icon bar beneath the grid:  

   
Figure 32:  Action icons  

To see which action the active icon represents, hover over the icon with your mouse pointer to read a pop-up 

description:  

  

Change the action for a highlighted item by clicking the appropriate icon on the icon bar. Scroll through and review 

each item on the grid.   
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For example: In Figure 28, Joe’s Restaurant is currently set to synchronize   (that is, it will import into 

QuickBooks). If you do not want this customer to import into QuickBooks, highlight the customer name in the list, 

then click the Do not synchronization icon   on the icon bar beneath the grid. This will change the action 

icon listed in the Action column.  

The integration client will automatically attempt to link customers that exist in both systems. If you want to change 

how customers have been linked, you may choose to link customers manually.  

To manually link customers, select a customer from each side of the customer grid, then click on the appropriate 

icon.   

1. Click the first customer you want to link from either the Field Service Management or QuickBooks side of 

the grid.  

2. Select the corresponding customer you want to link from the other side of the grid by holding down <Ctrl> 

and clicking on the customer name.  

3. Select which customer record information will be used when the customers are synchronized by clicking 

on the appropriate icon from the icon bar.   

  
Figure 33:  Manual customer synchronization (hold down <Ctrl> while clicking the second customer)  
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In Figure 30, Bulrush Art & Design from the web application is being synchronized with Bulrush Art & Design from 

QuickBooks. The user in this example is choosing to synchronize from QuickBooks, which means that customer 

information from QuickBooks will be used in both the web application and QuickBooks for this customer.  

Caution: Once customers from QuickBooks and the web application have been linked, they cannot be unlinked.  

Item Synchronization  

Once the customer synchronization is complete, click Next to begin the Item Synchronization. Click Next again 

once the retrieval is complete. This will produce the item synchronization grid.  

  
Figure 34: Corrigo Integration Client Item synchronization grid  

Scroll through the list of items and review.   

To stop the export of any item that is scheduled to export (synchronize), highlight the item then click the Do Not 

Synchronize icon  from the icon bar beneath the grid.  

To export any item that is set to not synchronize, highlight the item then click the Synchronize icon  or  

(depending upon the direction of the export) from the icon bar beneath the grid.  

Other action options are available. Highlight an item, then hover over active icons on the icon bar to produce a 

pop-up description of the action available.  
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Note: Changes to existing items in QuickBooks are automatically synchronized with the Field Service Management 

web application via the On-Demand synchronization. You do not need to run the process for this synchronization 

to occur. To synchronize item updates that were made in Field Service Management with matching items in 

QuickBooks, or to decrement inventory in QuickBooks that was sold through Field Service Management, you must 

run the integration client.  

Group Item Synchronization  

Once the item synchronization is complete, click Next to begin the Item Group Synchronization. Click Next again 

once the retrieval is complete. This will produce the item group synchronization grid as shown below.   
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Figure 35: Corrigo Integration Client Group Item synchronization grid  

Scroll through the list of items and review.   

To stop the export of any group item that is scheduled to export (synchronize), highlight the item then click the Do 

Not Synchronize icon  from the icon bar beneath the grid.  

To export any group item that is set to not synchronize, highlight the item then click the Synchronize icon 

 (depending upon the direction of the export) from the icon bar beneath the grid.  

Other action options are available. Highlight an item, then hover over active icons on the icon bar to produce a 

pop-up description of the action available.  

Note: Group Items added to or modified in QuickBooks are automatically synchronized with the Service 

Management web application. You do not need to run the wizard for this synchronization to occur. To synchronize 

group item updates that were made in Field Service Management with matching items in QuickBooks you must run 

the integration client.  

Click Next to proceed to the Retrieval of employees with approved invoices step.  
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Retrieval of Employees with Approved Invoices  

This step in the synchronization wizard will appear if, “Do you want to populate the Sales Rep field…” field is set to 

‘Yes’ in basic invoice settings in the integration settings wizard.   

  
Figure 36: Retrieval of employees with approved invoices   

Click Next to proceed to the employee, sales rep mapping step.  
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Associate Field Service Management employees with QuickBooks employees and Sales Reps  

  
Figure 37:  Employee and sales rep mapping grid  

Employees with approved invoices will be retrieved and will be listed in Field Service Management column as in the 

screen shot above. If the employee/sales rep is already mapped names will appear in the respective columns 

otherwise ‘CREATE NEW’ option will be selected by default. You have to option to map employees/sales rep or 

create them as new in QuickBooks. Sales Rep initials will be autopopulated but you have the option to change it if 

needed.   

Invoices exported to QuickBooks will have sales rep initials populated in the Sales Rep field.  

Click on Next to proceed to Invoice retrieval step.  

  

Invoice Export  

Invoice export is completed using the same method as customer synchronization. However, invoices are only 

exported from the web application into QuickBooks. QuickBooks invoices do not export into the web application. 

Invoices must have a status of Approved in the web application in order to be exported.  
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Figure 38: Corrigo Integration Client Invoice synchronization grid  

You can choose to post invoices at a customer or a job level. This depends on the ‘Configure Posting Invoices’ 

setting in Field Service Managementat Settings > Financial > Posting Invoices. Based on that setting invoices will be 

posted at the customer or job level.  

Pre-requisites for posting invoices to Jobs in QuickBooks:  

1. Pick ‘On Sites’ for the question ‘How would you like to post invoices?’ in Settings > 

Financial > Posting Invoices.  

2. You should have opted to sync both customers and jobs in Integration settings i.e. you 

should have selected ‘Yes’ to the question ‘Do you use jobs as locations in QuickBooks?’ 

in Customer settings in Integration Wizard Settings.  

  

Notes Regarding Invoice Export  

Long Invoice Numbers: Invoices exported into QuickBooks will retain the same invoice number that was assigned 

in Field Service Management, except when the Field Service Management number is longer than eleven 

characters. Since QuickBooks does not support more than an eleven character invoice number, a longer Field 
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Service Management invoice number will be truncated from left to right until it is shortened to eleven characters. 

For example, a Field Service Management invoice numbered: East-032108-0000007 would be shortened to  

2108-000007  

The full Field Service Management invoice number will be included in the memo field of the QuickBooks invoice for 

easy reference. In this example, the QuickBooks invoice memo would appear as:  

  

During synchronization, you will receive a message informing you if invoice numbers have been truncated.   

  

You can change your Field Service Management invoicing scheme through Settings >Work Zone > Edit Work Zone 

>WO Numbering to avoid having numbers truncated.  

Invoice Discounts: When invoices with line item discounts are exported to QuickBooks, each item discounted will 

include a discount line item beneath it. If multiple, identical items are marked for discount, they will be subtotaled. 

A total discount line item for all identical items will appear beneath that subtotal.  
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 Figure 39:  Invoice details screen showing discount line items in Field Service Management  
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Figure 40:  Discounts in Field Service Management (top) will export to QuickBooks as a line item (bottom)  

Note: Any changes made to invoices in QuickBooks will not reflect in the corresponding invoice within the web 

application.  

Payment Method Mapping  

In this step, payment methods created in the web application are mapped to payment methods within QuickBooks. 

For each web application payment method, choose the corresponding QuickBooks payment method from the 

drop-down options list.  
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Figure 41: Corrigo Integration Client Payment Methods mapping grid  

Note: If you choose to Skip this synchronization, the option to export payment methods will appear again on the 

next synchronization.  

Changed Payments Import  

In this step, changed payments are retrieved from the web application then imported into QuickBooks. If you need 

to view or cancel an import, click to highlight a customer, then click the appropriate icon on the icon bar beneath 

the grid.  

A valid QBMS (QuickBooks Merchant Services) account is required in order to synchronize credit card payments. 

Visit http://fieldservicesuccess.com/2012/08/17/credit-card-processing-in-the-field-integration-with-quickbooks-

merchant-services/ to set up a valid account for your QuickBooks company.  

  

Note: Credit card security standards allow for only the last four digits of a credit card number to be stored on a 

computer system. Corrigo has implemented this standard in order to protect customers. Intuit implemented this 

security requirement in 2007 and newer versions of the QuickBooks software.  

  

http://fieldservicesuccess.com/2012/08/17/credit-card-processing-in-the-field-integration-with-quickbooks-merchant-services/
http://fieldservicesuccess.com/2012/08/17/credit-card-processing-in-the-field-integration-with-quickbooks-merchant-services/
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Figure 42: Corrigo Integration Client Payment Import grid  

Click Next when done. The final screen of the Synchronization Wizard will appear. Click Finish when the 

synchronization is complete.    

Error Reconciliation  

The synchronization may fail for individual items during any stage of the process. If this happens, you can view the 

reason each item failed in order to correct the error.  
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Figure 43: Error messages during customer synchronization  

If errors occur during synchronization, the Warnings and Errors screen will appear once a particular stage of the 

synchronization process is complete. The messages will offer information on why the information did not 

synchronize.  

You have the option to save the error report to a formatted text file or print the error report. Save or print by 

choosing the appropriate icon in the lower left corner of the Warnings and Errors window. By saving or printing the 

error report, you can use it later to fix the integration errors. Once errors are fixed, you can try synchronization 

again.   

Note: You can also email the error report file created with the Save to File feature directly to Corrigo support if you 

need help in understanding or fixing errors. See Technical Support at the end of this guide for contact information.  

Automatic proceed to next step  

You will be automatically taken to the next step in the synchronization wizard after a delay of about 5 seconds, if 

there are no items to synchronize. You will be required to take an action on the screen only if there are some items 

to synchronize.  
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Time Card Synchronization (for Time Card users)  

The Time Card synchronization step is a one-way transfer of data from Field Service Management to QuickBooks. It 

consists of two phases.  

During the first phase, full names of Field Service Management employees with approved time cards are compared 

with employee names in QuickBooks. The names are matched by exact spelling (capitalization and multiple spaces 

within a name are ignored). Two possible scenarios can occur:  

• If a match is found in QuickBooks for a Field Service Management Time Card employee with an approved 

time card, the corresponding names are associated in a synchronization grid.  

• No match is found. If this occurs, then the grid will allow you to:  

o  Associate the Field Service Management Time Card employee with an existing QuickBooks 

employee  

<OR>   

o  Add the Field Service Management Time Card employee to QuickBooks  

To change the association of a Field Service Management user with a QuickBooks user, select the QuickBooks 

employee from the drop-down menu in the QuickBooks column of the Employees association grid (see Figure 38). 

To add a user, select Create New from the drop-down menu.  

Note: Time Card employees being exported from Field Service Management must either exist in QuickBooks, be 

created in QuickBooks through the synchronization wizard, or be associated with existing QuickBooks employees. 

The Time Card Synchronization cannot continue until this step is completed.  
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Figure 44:  Employees association grid  

Once the employee associations have been made, click Next to start the Retrieval of approved Time Cards.  

The next screen to appear will be the Time Cards Synchronization. On this screen, you can accept the Time Card 

records if no payroll items need to be specified, or return to Field Service Management and reopen the time card 

for editing.   

Approved time cards are retrieved as shown below if you had selected ‘No’ to the setting, ‘Do you want to import 

Customer:Site information for time records imported from Intuit Field Service Management ES?’. Note that there 

are no customer:site in the grid below.  
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Figure 45: Retrieval of approved Time Cards processing  

Approved time cards are retrieved as shown below if you had selected ‘Yes’ to the setting, ‘Do you want to import 

Customer:Site information for time records imported from Intuit Field Service Management ES?’. Note that there 

are customer:site information for each time record in the grid below.  
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Figure 46: Retrieval of approved Time Cards processing including customer:job information  

  

If an employee needs a payroll item specified, the employee name will be marked with . This indicates that the 

hourly wage records either do not exist, are incomplete, or conflict between Field Service Management and 

QuickBooks for the highlighted employee. Click the Specify payroll items icon at the bottom of the grid to enter 

the correct hourly wage rate. This will produce an editing screen where you can correct any discrepancies (see 

Figure 40).  
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 Figure 47:  Time Card Synchronization (above) and Specify payroll items edit screen (below)  

Click OK when payroll items have been edited. Click Next to complete synchronization.  
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Running Corrigo Integration in network share setup  
If you work with QuickBooks in a multi-user mode in a network shared environment there might be need for more 

than one user to be responsible for running the integration. If that is the case then there is an advanced setting 

you need to do in order to enable the Integration Client to work in such an environment.  

You will be required to do the advanced settings only under the following conditions:  

 You run QuickBooks in multi-user mode AND  

 You have QuickBooks company file in a network shared folder AND  

 You would like to have more than one person responsible for running the integration  

Follow these steps to set up Corrigo Integration in a network share environment:  

  

1. Download and install integration client on computer A  

2. Do the basic settings (refer Using Set up Wizard section for details) and complete initial sync  

3. Copy the cnqb.mdb file from C:\programdata\corrigo\corrigo integration\CnQb.mdb. Note: The 

Programdata folder is a hidden folder by default.  If you want to set up the FSM Sync on multiple 

computers, please email FSM Technical Support via Support@corrigo.com so we can help you configure 

this correctly. 

4. Open settings and click on the CQ icon to open up the menu  

 
Figure 48:  Advanced settings menu  

 

mailto:Support@corrigo.com
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5. Click on Advanced Settings  

  
Figure 49:  Advanced settings dialog  

 

6. Check the ‘Override client repository location’ checkbox. (Note: If you are making this setting on Vista or 

Windows 7, you need to have administrative rights to configure this setting)  

7. Enter the path of the shared location where the cnqb.mdb was copied to  

8. Click on Ok. Now the Integration client will use the repository file that is placed in the shared folder in 

network.   

Note: The repository file is an access database that stores all mappings between Field Service 

Management and QuickBooks and synchronization details.  

9. Download and install client on computer B  

10. Note that computer B should also be using the same QB company file which is in the shared location.  

11. Repeat steps 4 to 7.  

12. The settings you made in computer A will automatically be populated in Computer B since the cnqb.mdb 

is now shared  

13. Step through the settings until you hit finish.  

14. Run the sync from Computer B  
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Automatic Update of the Corrigo Integration Client  

Once your Corrigo Integration Client is installed, it will automatically check for updates each time you launch QuickBooks 

and open the company file. If a newer version of the client exists, you will be prompted to upgrade. Click Yes to upgrade 

when prompted.  

  
 

  
Figure 50:  If a newer version of the Corrigo Integration Client exists, you will be prompted to upgrade (top). Click 

Finish when done.  

Once the upgrade is completed, click Finish. You will not need to re-boot your computer.  
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Troubleshooting  

Frequently Asked Questions  

I just added information in my web application, but it doesn’t appear in the synchronization wizard. Why?  

If you added information to the web application after the synchronization wizard was started in 

QuickBooks, the information will not appear in any synchronization grid. You must exit the wizard and re-

start it.  

I receive a message that states, “The previous version of Client Data Repository (CnQb.mdb) has been found…” 

while installing the Corrigo Integration Client.  

The repository is a file containing information from previous integrations. If you want to retain 

synchronization information from previous integrations, select Yes. Select No if you want to create a new, 

empty repository. You may want a new repository if you are integrating with a new QuickBooks company 

or if you are moving from a trial version of Field Service Management where you entered sample data 

that you do not want to retain. Contact Corrigo FSM Technical Support if you are unsure of how to 

proceed.   

It appears as though I’ve installed the Corrigo Integration Client for QuickBooks successfully.  

However, when I log into QuickBooks, I don’t see the Corrigo Integration options on my menu. Why?  

In order to verify the installation and start the initial synchronization wizard, you must sign into 

QuickBooks as an administrator.  End all QB processes and run QB as an admin, or contact FSM Technical 

Support.  

I received the message “The company file cannot be closed at this time because there is another application 

(CorrigoNet Integration) which is using it.” Now my Corrigo Integration screen is not functioning correctly. Why?  

You have attempted to close QuickBooks while the Corrigo Integration client was running. You must close 

any of the Corrigo Integration forms prior to closing QuickBooks. If your integration client is not 

functioning correctly, close the client, then re-start it from the QuickBooks file menu.  

Shortly after starting the synchronization, I received the message “Application doesn’t have access to 

QuickBooks personal data. Please correct this and click Next to continue”.  How do I correct this problem?  

Time Card users must configure QuickBooks to allow the Corrigo Integration Client access to personal 

information. Go to Edit>Preferences>Integrated Applications>Company Preferences (for most versions 

of QuickBooks. Consult your QuickBooks documentation if Company Preferences is not found on this path 

for your version). To configure:  

1. Click on Corrigo Integration (under Application Name, may appear as Intuit Field Svc Integration).  

2. Click the Properties button.  

3. Click the Access Rights tab atop the Properties edit screen.  
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4. Check each of the following settings  

a. Allow this application to read and modify this company file  

b. Allow this application to access Social Security Numbers, customer credit card information, and 

other personal data  

5. Click OK when done.  

See QuickBooks Settings in this guide for additional information.  

While synchronizing QuickBooks 2008 with Field Service Management, I received the message: "There was an 

error when converting the percent [your tax rate] in the field "TaxRate" (“Error Code 3050). What should I do?  

You are running the synchronization in multi-user mode. Switch to single-user mode to run the 

synchronization, and invoices with non-zero tax will export. This is a known issue with QuickBooks 2008.  

I get ‘Exception occurred on QuickBooks request: This request cannot be processed from within data event 

callback procedure”. What should I do?  

This is an internal error thrown by QuickBooks. You can overcome this error by clicking on cancel and 

starting over the sync process again.  

FSM Technical Support:  

 Helpful videos during the Installation and Setup process: http://vimeo.com/intuitfieldsvc/albums to watch 

the “Phase 1” video series. 

 Field Service Management technical support:   1-800-517-2871 (toll-free)  

 Email: support@corrigo.com 

 Local Experts for personalized setup assistance, QB file cleanup, and FSM training: 

http://fieldservicesuccess.com/2012/11/07/local-experts  

 

 

http://vimeo.com/intuitfieldsvc/albums
mailto:support@corrigo.com
http://fieldservicesuccess.com/2012/11/07/local-experts
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